Legal Notice

For information about NetIQ trademarks, see https://www.netiq.com/company/legal/.

Copyright (C) 2018 NetIQ Corporation. All rights reserved.
About this Book and the Library

The *Identity Manager Driver for Office 365 and Azure Active Directory Implementation Guide* explains how to install and configure the Identity Manager Driver for Azure Active Directory.

**Intended Audience**

This book provides information for administrators implementing Identity Manager, application server developers, Web services administrators, and consultants.

**Other Information in the Library**

For more information about the library for Identity Manager, see the following websites:

- Identity Manager documentation website (https://www.netiq.com/documentation/identity-manager-47/)
- Identity Manager drivers documentation website (https://www.netiq.com/documentation/identity-manager-47-drivers/)
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>About this Book and the Library</td>
<td>3</td>
</tr>
<tr>
<td>About NetIQ Corporation</td>
<td>7</td>
</tr>
<tr>
<td>About This Guide</td>
<td>9</td>
</tr>
<tr>
<td><strong>1 Understanding the Office 365 and Azure Active Directory Driver</strong></td>
<td>11</td>
</tr>
<tr>
<td>Understanding How the Driver Works</td>
<td>11</td>
</tr>
<tr>
<td>Data Transfers Between Systems</td>
<td>13</td>
</tr>
<tr>
<td>Driver Features</td>
<td>13</td>
</tr>
<tr>
<td>- Supported Operations</td>
<td>13</td>
</tr>
<tr>
<td>- Schema Extension</td>
<td>14</td>
</tr>
<tr>
<td>- License Handling</td>
<td>14</td>
</tr>
<tr>
<td>- Hybrid Mode</td>
<td>14</td>
</tr>
<tr>
<td>- Entitlements</td>
<td>16</td>
</tr>
<tr>
<td>Planning to Install the Driver</td>
<td>16</td>
</tr>
<tr>
<td>- Installation Requirements</td>
<td>16</td>
</tr>
<tr>
<td>- Options for Installing the Driver Shim</td>
<td>16</td>
</tr>
<tr>
<td><strong>2 Installing the Driver Files</strong></td>
<td>19</td>
</tr>
<tr>
<td>Preparing for Installation</td>
<td>19</td>
</tr>
<tr>
<td>- Prerequisites for the Driver</td>
<td>19</td>
</tr>
<tr>
<td>- Prerequisites for Identity Manager Exchange Service</td>
<td>19</td>
</tr>
<tr>
<td>- Prerequisites for OAuth 2.0</td>
<td>20</td>
</tr>
<tr>
<td>- Prerequisites for Support of Modern Authentication</td>
<td>23</td>
</tr>
<tr>
<td>Installing the Driver and the Identity Manager Exchange Service</td>
<td>24</td>
</tr>
<tr>
<td>- Verifying and Starting the Identity Manager Exchange Service</td>
<td>24</td>
</tr>
<tr>
<td>- Verifying the Provisioning of Exchange Mailbox</td>
<td>25</td>
</tr>
<tr>
<td><strong>3 Creating a New Driver Object</strong></td>
<td>27</td>
</tr>
<tr>
<td>Creating the Driver Object in Designer</td>
<td>27</td>
</tr>
<tr>
<td>- Importing the Driver Packages</td>
<td>27</td>
</tr>
<tr>
<td>- Installing the Driver Packages</td>
<td>27</td>
</tr>
<tr>
<td>- Configuring the Driver</td>
<td>32</td>
</tr>
<tr>
<td>- Deploying the Driver</td>
<td>33</td>
</tr>
<tr>
<td>- Starting the Driver</td>
<td>34</td>
</tr>
<tr>
<td>- Activating the Driver</td>
<td>34</td>
</tr>
<tr>
<td><strong>4 Upgrading an Existing Driver</strong></td>
<td>35</td>
</tr>
<tr>
<td>What's New</td>
<td>35</td>
</tr>
<tr>
<td>- What's New in Version 5.1.1.0</td>
<td>35</td>
</tr>
<tr>
<td>- What's New in Version 5.1.0.0</td>
<td>35</td>
</tr>
<tr>
<td>Working with MapDB 3.0.5</td>
<td>35</td>
</tr>
<tr>
<td>- Understanding Identity Manager 4.7 Engine Support for Driver Versions</td>
<td>35</td>
</tr>
<tr>
<td>- Manually Removing the MapDB Cache Files</td>
<td>36</td>
</tr>
<tr>
<td>Upgrading the Driver</td>
<td>36</td>
</tr>
<tr>
<td>- Upgrading the Installed Packages</td>
<td>36</td>
</tr>
</tbody>
</table>
About NetIQ Corporation

We are a global, enterprise software company, with a focus on the three persistent challenges in your environment: Change, complexity and risk—and how we can help you control them.

Our Viewpoint

Adapting to change and managing complexity and risk are nothing new

In fact, of all the challenges you face, these are perhaps the most prominent variables that deny you the control you need to securely measure, monitor, and manage your physical, virtual, and cloud computing environments.

Enabling critical business services, better and faster

We believe that providing as much control as possible to IT organizations is the only way to enable timelier and cost effective delivery of services. Persistent pressures like change and complexity will only continue to increase as organizations continue to change and the technologies needed to manage them become inherently more complex.

Our Philosophy

Selling intelligent solutions, not just software

In order to provide reliable control, we first make sure we understand the real-world scenarios in which IT organizations like yours operate—day in and day out. That's the only way we can develop practical, intelligent IT solutions that successfully yield proven, measurable results. And that's so much more rewarding than simply selling software.

Driving your success is our passion

We place your success at the heart of how we do business. From product inception to deployment, we understand that you need IT solutions that work well and integrate seamlessly with your existing investments; you need ongoing support and training post-deployment; and you need someone that is truly easy to work with—for a change. Ultimately, when you succeed, we all succeed.

Our Solutions

- Identity & Access Governance
- Access Management
- Security Management
- Systems & Application Management
- Workload Management
- Service Management
Contacting Sales Support

For questions about products, pricing, and capabilities, contact your local partner. If you cannot contact your partner, contact our Sales Support team.

Worldwide: www.netiq.com/about_netiq/officelocations.asp
United States and Canada: 1-888-323-6768
Email: info@netiq.com
Web Site: www.netiq.com

Contacting Technical Support

For specific product issues, contact our Technical Support team.

Worldwide: www.netiq.com/support/contactinfo.asp
North and South America: 1-713-418-5555
Europe, Middle East, and Africa: +353 (0) 91-782 677
Email: support@netiq.com
Web Site: www.netiq.com/support

Contacting Documentation Support

Our goal is to provide documentation that meets your needs. The documentation for this product is available on the NetIQ Web site in HTML and PDF formats on a page that does not require you to log in. If you have suggestions for documentation improvements, click Add Comment at the bottom of any page in the HTML version of the documentation posted at www.netiq.com/documentation. You can also email Documentation-Feedback@netiq.com. We value your input and look forward to hearing from you.

Contacting the Online User Community

NetIQ Communities, the NetIQ online community, is a collaborative network connecting you to your peers and NetIQ experts. By providing more immediate information, useful links to helpful resources, and access to NetIQ experts, NetIQ Communities helps ensure you are mastering the knowledge you need to realize the full potential of IT investments upon which you rely. For more information, visit community.netiq.com.
About This Guide

This guide explains how to install and configure the Identity Manager Driver for Office 365 and Azure Active Directory.

**Audience**

This guide is intended for administrators implementing Identity Manager, application server developers, Web services administrators, and consultants.

**Feedback**

We want to hear your comments and suggestions about this manual and the other documentation included with this product. Please use the User Comments feature at the bottom of each page of the online documentation, or go to www.novell.com/documentation/feedback.html and enter your comments there.

**Documentation Updates**

For the most recent version of this document, see the Identity Manager Drivers Documentation Web site (http://www.netiq.com/documentation/idm47drivers/index.html).

**Additional Documentation**

For information on Identity Manager, see the Identity Manager Documentation Web site (http://www.netiq.com/documentation/idm47drivers).
Understanding the Office 365 and Azure Active Directory Driver

The Identity Manager Driver for Office 365 and Azure Active Directory (Azure AD driver) allows you to seamlessly provision and deprovision users, group memberships, exchange mailboxes, roles, and licenses to Azure AD cloud. You can also configure the driver to integrate with Identity Manager Service for Exchange Online (Identity Manager Exchange Service) for synchronizing Office 365 attributes.

As a known information, Microsoft Office 365 is deprecating the Basic authentication method. To configure the driver with modern authentication, it is recommended to upgrade your driver to 5.1.3 or later, with the prerequisites as explained in, “Prerequisites for the Driver” on page 19, “Prerequisites for Identity Manager Exchange Service” on page 19, and “Prerequisites for OAuth 2.0” on page 20 are met, and then proceed with the “Prerequisites for Support of Modern Authentication” on page 23.

In general, you can perform the following tasks by using the driver:

- Synchronize users and groups on Publisher and Subscriber channels
- Provision and deprovision mail and mailbox users, distribution, and mail enabled security and Office 365 groups
- Assign and revoke roles, group membership, and licenses using entitlements
- Extend the Azure AD schema
- Synchronize passwords from the Identity Vault

This section contains high-level conceptual information about the Azure AD driver.

- “Understanding How the Driver Works” on page 11
- “Data Transfers Between Systems” on page 13
- “Driver Features” on page 13
- “Planning to Install the Driver” on page 16

Understanding How the Driver Works

The following figure shows the data flow between Identity Manager and the Azure AD driver:
Azure AD Driver

The Azure AD driver allows you to seamlessly provision and deprovision users, group memberships, exchange mailboxes, roles, and licenses to Azure AD (cloud). The driver synchronizes the user identity information between the Identity Vault and Azure AD and keeps this information consistent at all times.

Identity Manager Service for Exchange Online

The Azure AD driver uses the Identity Manager Exchange Service to provision or deprovision user mailboxes, mail users, create or remove distribution lists and security groups on Office 365 Exchange Online. For more information on configuring the service, see Chapter 7, “Understanding Identity Manager Exchange Service,” on page 47.

PowerShell

The Azure AD driver uses PowerShell for executing Exchange operations such as creation of Exchange mailbox, mail users, and groups.

Internet Protocols

The Azure AD driver uses the following Internet protocols to exchange data between Identity Manager and Azure AD.

- **REST (Representational State Transfer):** An HTTP-based protocol for exchanging messages over the network. It supports POST, PUT, GET, PATCH, DELETE methods to communicate with the application logic.

- **HTTPS (Hypertext Transfer Protocol):** An HTTP protocol over SSL (Secure Socket Layer) as a sub-layer under the regular HTTP application layering. HTTPS encrypts and decrypts user page requests as well as the pages that are returned by the web server.

  Azure AD processes a request and returns a REST response to the driver shim. The shim receives the response as an array of bytes and converts it to an XML document before passing it back to the driver policies. The input transformation style sheet processes the response and converts it into appropriate XDS that is reported back to the Identity Manager engine.

Identity Manager Engine

The Identity Manager engine uses XDS, a specialized form of XML (Extensible Markup Language), to represent events in the Identity Vault. Identity Manager passes the XDS to the driver policy which can consist of basic policies, DirXML Script, and XSLT (Extensible Stylesheet Language Transformation) style sheets. The Azure AD driver uses REST protocol to handle the HTTP transport of data between the Identity Vault and Azure AD.

The Subscriber channel receives XDS command documents from the Identity Manager engine, converts them to Azure AD API (Application Program Interface) calls, and executes them. The driver shim translates the XDS to XML payload on the Subscriber channel and then invokes the appropriate REST endpoints exposed by Azure AD for Object CRUD (Create, Read, Update, and Delete) operations.

Remote Loader

A Remote Loader enables a driver shim to execute outside of the Identity Manager engine, remotely on a different machine. The Remote Loader passes the information between the shim and the Identity Manager engine.
For the Azure AD driver, you can choose to install the driver shim on the server where the Remote Loader is running.

**Data Transfers Between Systems**

The Azure AD driver supports data transfer on the Publisher and the Subscriber channels.

The Publisher channel controls the data transfer as follows:

- Reads events from the configured domains.
- Submits that information to the Identity Vault.

The Subscriber channel controls the data transfer as follows:

- Watches for the events from the Identity Vault objects.
- Makes changes to Azure AD based on the event data.

You can configure the driver filter to allow both Azure AD and Identity Vault to modify the attribute(s). In this configuration, the most recent change determines the attribute value, except for merge operations that are controlled by filters and the merge authority.

The Exchange schema uses a different casing than the Azure AD schema where the first character of an Exchange schema attribute is uppercase, which is lowercase in Azure AD schema.

**Driver Features**

The Azure AD driver supports the following features:

- “Supported Operations” on page 13
- “Schema Extension” on page 14
- “License Handling” on page 14
- “Hybrid Mode” on page 14
- “Entitlements” on page 16

**Supported Operations**

By default, the Azure AD driver synchronizes user and group objects, and Exchange mailboxes. You can customize the driver to synchronize additional classes and attributes.

The driver supports the following operations on the Publisher channel:

- Add, Modify, Delete, and Query operations.
- Migrate operation only through Azure AD attributes. Exchange attributes are not supported for migration.

The following Exchange groups can be added through the Publisher channel:

- Office 365 Group
- Distribution Group
- Security Group
NOTE: You need to write a policy to set a value for Equivalent to Me while modifying a group membership.

The driver supports the following operations on the Subscriber channel:

- Add, Modify, Delete, Migrate, and Query operations on users and groups.
- Add or delete licenses only on user objects.
- Set or reset a password only on user objects.
- Execute PowerShell cmdlets using policies.
- Assign or revoke roles and licenses in hybrid mode.

The following Exchange groups can be added through the Subscriber channel:

- Distribution Group
- Security Group
- Office 365 Group

Schema Extension

The Azure AD driver allows you to extend the Azure AD schema to include different types of attributes such as Integer, Boolean, and String using the driver parameters. For example, you can add, remove, or change extension attributes on a user or a group class with the allowed attribute types. For more information, see the Microsoft website.

License Handling

In the Office 365 driver, you created custom licenses to disable specific service plans. For example, to disable Office 365 ProPlus from your enterprise plan, you specified this string in the driver configuration: OFFICESUBSCRIPTION. For more information, see the NetIQ Identity Manager Driver for Office 365 Implementation Guide.

In the Azure AD driver, license handling is simplified. The driver lists all the available service plans for your subscription in Identity Applications. Each service plan can be individually assigned or revoked for a user through the License Entitlement resource. For example, if you want to assign only Office 365 ProPlus to a user, select OFFICESUBSCRIPTION from the list of service plans. The driver also supports assigning or revoking multiple plans to a user.

Hybrid Mode

The following figure shows the hybrid mode deployment scenario:
In this deployment, Azure AD Connect integrates on-premise Active Directory with Azure Active Directory. Azure Active Directory does not allow modifications on user and group objects that were synchronized through Azure AD Connect. However, it allows you to provision roles and licenses to the users. To accomplish this, you must deploy an Azure AD driver in hybrid mode. To synchronize identities from the Identity Vault to on-premise Active Directory, you must have an AD driver in your environment.

NOTE: If you have upgraded to the 5.0.1 version of the driver, the group membership entitlement and exchange role entitlement are supported in hybrid mode. For more information on entitlements supported in 5.0.1, see Exchange Role Entitlement.

To provision roles and licenses, set the driver in hybrid mode in Designer or iManager. For more information, see “Configuring the Driver” on page 32.

The driver performs the following actions when operating in hybrid mode:

- When a user is provisioned to AD through AD driver’s user account entitlements and the user is synchronized to Azure AD through Azure AD Connect, the driver updates the user association in the Identity Vault.
- When a user is deleted from Azure AD, the driver removes the association for the user from the Identity Vault.
- When a user is granted or revoked roles or licenses through entitlements, the driver grants or revokes roles or licenses after an association is created for the user.
- When an account entitlement is revoked for a user in AD, the driver removes the association for the user from the Identity Vault.

NOTE: You cannot add users, delete users, and modify user attributes through the publisher channel when you operate the Azure AD driver in hybrid mode. However, the Azure AD driver will update the associations accordingly.

In hybrid mode, the AD driver’s account tracking takes precedence over Azure AD driver. The password synchronization to the Identity Vault is handled by AD driver in hybrid mode.
Entitlements

The Azure AD driver supports entitlements. By default, it supports UserAccount, Group, Licenses, and Roles entitlements.

When using entitlements, an action such as provisioning an account in the target directory is delayed until the proper approvals have been made. In Role-Based Services, rights assignments are made based on attributes of a user object. Entitlements standardize a method of recording this information on objects in the Identity Vault. From the driver perspective, an entitlement grants or revokes the right to resources in Azure AD. You can use entitlements to grant the rights to an account in Azure AD, to control group membership, roles, and licenses.

Planning to Install the Driver

This section provides information for planning the installation and configuration for the driver.

- “Installation Requirements” on page 16
- “Options for Installing the Driver Shim” on page 16

Installation Requirements

The Azure AD driver requires the following applications and files:

- Identity Manager 4.6 or later
- Identity Manager Designer 4.6 or later
- Azure AD driver files
  - NIdM_Driver_4.5_O365_AzureAD.zip
- Azure AD driver packages (1.0.0)
  - Azure AD Base
  - Azure AD Default
  - Azure AD Exchange Default
  - Azure AD PasswordSync
  - Azure AD Audit Entitlements
  - Azure AD Cloud Only Entitlements
  - Azure AD Hybrid Entitlements
  - Azure AD Account Tracking
  - Azure AD Data Collection
  - Azure AD Managed System Information

Options for Installing the Driver Shim

You can install the driver shim on the Identity Manager server or the Remote Loader server.

For more information about the platforms supported with Identity Manager or the Remote Loader, see the NetIQ Identity Manager Technical Information website (https://www.netiq.com/products/identity-manager/advanced/technical-information/).
The Remote Loader loads the driver and communicates with the Identity Manager engine on behalf of the driver installed on the remote server. For information about configuring the Identity Manager drivers with the Remote Loader, see Configuring the Remote Loader and Drivers in the NetIQ Identity Manager Setup Guide for Windows.
Installing the Driver Files

You can install the Azure AD driver on the Identity Manager server or with the Remote Loader.

Preparing for Installation

This section provides the prerequisites, considerations, and system setup needed to install the driver:

- “Prerequisites for the Driver” on page 19
- “Prerequisites for Identity Manager Exchange Service” on page 19
- “Prerequisites for OAuth 2.0” on page 20
- “Prerequisites for Support of Modern Authentication” on page 23

Prerequisites for the Driver

The driver requires the following applications:

- Identity Manager 4.6 or later
- Identity Manager Designer 4.6 or later
- Identity Manager REST driver 1.0.0.1 or later

Prerequisites for Identity Manager Exchange Service

- Microsoft Windows Management Framework 4.0 (required for Windows Server 2008 R2)
- Microsoft Visual C++ 2017 Redistributable packages for Visual Studio
  Download the packages from the Microsoft Downloads website.
- Microsoft Online Services Sign-In Assistant for IT Professionals RTW
  Download the packages from the Microsoft Download Center website.
- Windows Azure AD Module for Windows PowerShell on the computer where you will install Windows PowerShell service.

Perform the following steps to upgrade PowerShell to the latest version:

1. Open a Windows PowerShell console.
2. Run the following Install-Module cmdlet or Install-Script cmdlet:
   - If it is a module: Install-Module -Name <moduleName> -RequiredVersion <version>
     For example, Install-Module -Name MSOnline -RequiredVersion 1.1.166.0
   - If it is a script: Install-Script -Name <scriptName> -RequiredVersion <version>
Identity Manager Exchange Service can be run on a user configured port. However, the service cannot be used with any other REST client tools.

**Prerequisites for OAuth 2.0**

The driver uses OAuth 2.0 protocol to authenticate to Azure AD. To support this protocol for authentication, you need to have a proxy application for the Azure AD driver on Azure AD. The Client ID and Client Secret allotted to the application will be later used in the Azure AD driver configuration. For more information about Azure Active Directory Application Proxy, see [Microsoft Azure documentation](#).

**Creating a Proxy Application on Azure AD**

A proxy application is created in the Azure Portal. Creating a proxy application involves the following steps:

1. Registering an application and obtaining a client ID. For more information see, [Registering an Application](#).
2. Generating an application password or the client secret. For more information see, [Certificates and Secrets](#).
3 Configuring API permissions (Delegated and Application permissions). Set the delegated and application permissions as shown in the following image. For more information see, Add permissions to access web APIs.

<table>
<thead>
<tr>
<th>APPLICATION PERMISSIONS</th>
<th>REQUIRES ADMIN</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>✓</strong> Read directory data</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>✓</strong> Read and write domains</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>✓</strong> Read and write directory data</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>✓</strong> Read and write devices</td>
<td>Yes</td>
</tr>
<tr>
<td>Read all hidden memberships</td>
<td>Yes</td>
</tr>
<tr>
<td>Manage apps that this app creates or owns</td>
<td>Yes</td>
</tr>
<tr>
<td>Read and write all applications</td>
<td>Yes</td>
</tr>
<tr>
<td>Read and write domains</td>
<td>Yes</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DELEGATED PERMISSIONS</th>
<th>REQUIRES ADMIN</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access the directory as the signed-in user</td>
<td>No</td>
</tr>
<tr>
<td>Read directory data</td>
<td>Yes</td>
</tr>
<tr>
<td>Read and write directory data</td>
<td>Yes</td>
</tr>
<tr>
<td>Read and write all groups</td>
<td>Yes</td>
</tr>
<tr>
<td>Read all groups</td>
<td>Yes</td>
</tr>
<tr>
<td>Read all users’ full profiles</td>
<td>Yes</td>
</tr>
<tr>
<td>Read all users’ basic profiles</td>
<td>No</td>
</tr>
<tr>
<td><strong>✓</strong> Sign in and read user profile</td>
<td>No</td>
</tr>
<tr>
<td>Read hidden memberships</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The Client ID and Client Secret can now be used for driver configurations or any other REST clients.

**Assigning the Rights to the Application**

1 Log in to PowerShell and connect to the Office 365 Exchange Online service by using the following command:

```
Connect-MSolService
```

2 To obtain the Client ID for your application, replace `<AppPrincipalId>` with the Client ID that you obtained from “Creating a Proxy Application on Azure AD” on page 20 and run the following commands in PowerShell.
Get-MsolServicePrincipal | ft DisplayName, <AppPrincipalId> -AutoSize

$ClientIdWebApp = '<AppPrincipalId>'

$webApp = Get-MsolServicePrincipal -AppPrincipalId $ClientIdWebApp

3 Assign the Company Administrator rights to your application using the Client ID obtained in Step 2 by running the following command:

Add-MsolRoleMember -RoleName "Company Administrator" -RoleMemberType ServicePrincipal -RoleMemberObjectId $webApp.ObjectID

The Company Administrator role will give you rights to delete the directory objects.

Ensure that the account used by the driver to connect to the Exchange Online service has the correct roles to load and execute the following cmdlets:

- New-Mailbox
- Set-Mailbox
- Get-Mailbox
- Remove-Mailbox
- New-MailUser
- Set-MailUser
- Get-MailUser
- Remove-MailUser
- Set-User
- Get-User
- New-DistributionGroup
- Set-DistributionGroup
- Get-DistributionGroup
- Get-Group
- Remove-DistributionGroup
- Add-DistributionGroupMember
- Remove-DistributionGroupMember
- Get-DistributionGroupMember
- Add-RoleGroupMember
- Remove-RoleGroupMember
- Get-RoleGroupMember
- New-UnifiedGroup
- Get-UnifiedGroup
- Set-UnifiedGroup
- Remove-UnifiedGroup
- Add-UnifiedGroupLinks
- Remove-UnifiedGroupLinks
- Get-UnifiedGroupLinks
Absence of the required roles prevents the driver from executing the cmdlets that require those roles.

**Prerequisites for Support of Modern Authentication**

As Microsoft Office 365 is deprecating the Basic authentication, you must now configure the driver with modern authentication method. You must also ensure to have the earlier mentioned prerequisites ("Prerequisites for the Driver" on page 19, "Prerequisites for Identity Manager Exchange Service" on page 19, and "Prerequisites for OAuth 2.0" on page 20) met, and then proceed with the following prerequisites.

The following prerequisites are specific to modern authentication. It is highly recommended to upgrade the driver version 5.1.x to 5.1.3 to support modern authentication.

**Installing the Microsoft Exchange Online PowerShell V2 (EXO V2)**

For Azure AD 5.1.3, you must mandatorily install the Microsoft Exchange Online PowerShell V2 module to support the new API's. For more information on EXO V2 module, see About the Exchange Online PowerShell V2 module.

- For prerequisites to install the EXO V2 module, see Prerequisites for EXO V2 module.
- For installing the EXO V2 module, see Install the EXO V2 module.

**Configuring Azure AD Proxy Application for Modern Authentication Methods**

**IMPORTANT:** This configuration is applicable for Azure AD Driver 5.1.3 and later versions only. It is highly recommended that you upgrade your driver instance to version 5.1.3 or later.

You must upgrade the Azure AD driver version to 5.1.3 as Microsoft Office 365 is deprecating the Basic authentication support. This deprecation enforces the driver to be configured with advance authentication method. It is mandatory to upgrade the existing driver version 5.1.x to 5.1.3 to support modern authentication.

If you are setting up the Azure AD driver 5.1.3 version, you must enable the permission in the Azure portal to access Microsoft Office 365 with modern authentication.

The procedure to set the permission is shown below:

1. Login to the Azure AD Portal.
2. Select Azure Active Directory.
3. Navigate to App Registration > find and select your application in the list (for example: <MySample_Azure_Appln>) > Authentication > Advanced Settings.
4. Set Treat Application as a Public Client permission to Yes.

**IMPORTANT:** The multi-factor authentication (MFA) must be disabled for the Azure account which is used with the driver.
Installing the Driver and the Identity Manager Exchange Service

The driver installation program guides you through the driver and the Identity Manager Exchange Service installation.

Perform the following actions to install and configure the Exchange Service:

1. Copy Exchange Service from [ISO]:\products\IDM\windows\setup\drivers\azuread\ExchangeService to any local drive on the server you intend to run this service.

2. Install Exchange Service by running InstallUtil InstallUtil.exe ExchServerHost.exe command from the folder where your ExchServerHost.exe is located.

   For example:<c:\ExchangeService>\<C:\Windows\Microsoft.NET\Framework64\v4.0.30319>\InstallUtil.exe ExchServerHost.exe

3. Ensure the server certificate is available in iManager. To create the server certificate, see “Securing Communication with Identity Manager Exchange Service” on page 40.

4. Open cmd prompt, and navigate to the local drive location where the ExchangeService is saved, as mentioned in Step 1 on page 40 (\products\IDM\windows\setup\drivers\azuread\ExchangeService\), and execute the command configureExchService.bat <port> <certificate_name>.

   For example: configureExchService.bat 9001 azuread. Where 9001 is the port number and azuread is the nickname of the certificate that was created in iManager.

5. To start the service, navigate to Control Panel > Administrative Tools > Services.

6. Right-click the IDMExchangeOnline service and select Start.

NOTE: To uninstall the service, open a .NET command prompt and issue the InstallUtil /u ExchServerHost.exe command.

NetIQ recommends you to use TLS 1.1 and TLS 1.2 protocols with the Identity Manager Exchange Service. If you are using ciphers and protocols such as RC4 and Triple DES, or SSLv2/v3 on a server running Identity Manager Exchange Service, you must disable them using the disableWeakCiphers.reg file provided in the Exchange Service installation directory. You can either execute the registry file or import the file into Windows Registry. After the changes are made, restart the server. For more information about restricting the use of certain cryptographic algorithms and protocols on Windows servers, see Microsoft Support Site.

Verifying and Starting the Identity Manager Exchange Service

After finishing the installation of Identity Manager Exchange Service, verify that the service is properly installed.
NOTE: Ensure that SSL is configured for the Identity Manager Exchange Service before starting the service. This is a mandatory step before running the service. For more information, see Securing Communication with Identity Manager Exchange Service.

1. From the Start menu, type regedit.
2. On the Registry Editor page, locate the service at HKEY_LOCAL_MACHINE > Software > Novell > ExchServer and verify that the Port and CertificateFriendlyName have the correct values.
   The CertificateFriendlyName must be the same as Certificate Alias that you specified in Step 1 of the “Securing Communication with Identity Manager Exchange Service” on page 40.
3. Navigate to the services that are running on your server and start the IDMExchangeOnline service.

Verifying the Provisioning of Exchange Mailbox

To verify the provisioned mailboxes for users, follow the procedure provided in the Microsoft Exchange Admin Center.
Creating a New Driver Object

You install the Azure AD driver files on the server where you want to run the driver, and then proceed to create the driver in the Identity Vault. You create the Azure AD driver by installing the driver packages or importing the basic driver configuration file and then modifying the driver configuration to suit your environment.

Creating the Driver Object in Designer

An administrator must use Designer to create the Azure AD driver.

The Azure AD driver is package-enabled and you must install and deploy the driver using Designer. You can use iManager to view and edit the deployed configuration. NetIQ recommends that you use Designer to perform any changes.

Importing the Driver Packages

The driver packages contain the items required to create a driver, such as policies, entitlements, and filters. These packages are only available in Designer and can be updated after they are installed. You should use the most current version of the packages in the Package Catalog before you can create a new driver object.

1 Open Designer.
2 In the toolbar, click Help > Check for Package Updates.
3 Click OK to update the packages or click OK if the packages are up-to-date.
4 Right-click Package Catalog and then select Import Package.
5 Select any Azure AD driver packages.
   or
   Click Select All to import all of the packages displayed.
6 Click OK to import the selected packages, then click OK in the successfully imported package message.

After the packages are imported, continue with Installing the Driver Packages.

Installing the Driver Packages

After you have imported the current driver packages into the Package Catalog, you can install the driver packages to create a new driver.

1 Open your project in Designer.
2 In the Modeler, right-click the driver set where you want to create the driver, then select New > Driver.
   Alternatively, you can drag and drop the Azure AD driver icon from the Cloud section of the Designer palette.
3 In the **Driver Configuration** wizard, select the **Azure AD Base** package from the list of base packages, then click **Next**.

4 Select the optional features to install for the Azure AD driver. All options are selected by default. The options are:

   - **Default Configuration**: This package contains the default configuration information for the driver. Always leave this option selected.

     **NOTE**: The **Azure AD Default** package and **Azure AD Exchange Default** package are included in the **Default Configuration** package. By default, the **Azure AD Exchange Default** package is not selected. Select this package if you plan to use the Identity Manager Exchange Service.

   - **Entitlements and License Support**: This package contains configuration information and policies for synchronizing user accounts, group membership, roles and licenses. If you want to enable account creation and auditing through entitlements, verify that this option is selected.

     To enable the hybrid mode, select the **Azure AD Hybrid Entitlements** package. In this mode, the driver supports only Roles and License entitlements.

   - **Password Synchronization**: This package contains the policies that enables the driver to synchronize passwords. If you want to synchronize passwords, ensure that this package is selected.

   - **Account Tracking**: This package contains the policies that enable you to track accounts for reports. If you are using Identity Reporting, ensure that this package is selected.

   - **Data Collection**: This package contains the policies that enables the driver to collect data for reports. If you are using the Identity Manager Reporting Module, ensure that this package is selected.

5 Click **Next**.

6 (Conditional) If there are package dependencies for the packages you selected to install, you must install them to install the selected package. Click **OK** to install the package dependencies listed.

7 (Conditional) If more than one type of package dependency must be installed, you are presented with these packages separately. Click **OK** to install any additional package dependencies.

8 On the **Driver Information** page, specify a name for the driver, then click **Next**.

9 On the **Driver Configuration** page, fill in the following fields to configure the driver:

   - **Authentication ID**: Provide the authentication information while configuring the domain connections for the driver. This is a qualified userprincipalname on Azure AD with login permissions. For example, admin@domain.onmicrosoft.com

     **NOTE**: The username that you specify must be an administrator and should have the Global Administrator role privileges. For more information on assigning a role to an administrator, see Microsoft documentation.

   - **Password**: Specify the password for the driver to authenticate to Azure AD.

   - **Driver Options**: To view the driver options, select **Show**.

   - **Client ID**: Specify the account name which the driver will use to access the Azure AD applications.

   - **Client Secret**: Specify the password for the Client ID to access the Azure AD applications.
NOTE: You created Client ID and Client Secret while creating a proxy application in Azure AD. For more information, see “Creating a Proxy Application on Azure AD” on page 20.

Show Schema Extensions Configuration: To show the schema extensions configuration options for the application (Azure AD), select Show.

Enable Hybrid Operation Mode: In hybrid mode, the driver provisions only roles and licenses while the users and groups are provisioned by the AD driver. By default, the parameter is set to Yes. If you want to run the driver in normal mode, set the option to No.

Activate Azure Directory Roles: By default, the driver obtains the roles that have been pre-activated in Azure Directory. If you want the driver to activate all Azure Directory roles, set this option to Yes. This fetches all the activated roles in Identity Applications. These roles are also available at the driver startup. Roles activation is one time activity and need not be performed again.

To obtain only pre-activated roles, leave the setting unchanged.

Existing Schema Extensions: To retain the previously-loaded configuration from Azure AD, select Preserve. To remove existing configuration, specify Remove.

Add a schema extension: Specify appropriate configuration details while adding a schema extension. You can add multiple schema extensions if required.

- **Name of extension**: Specify the name of the schema extension. For example, Title.
  
  If you create multiple schema extensions with the same name, the driver uses the first extension in the list and ignores the remaining extensions that have the same name.

- **Type of extension**: Specify the data type for the configured schema extension. Ensure that the data type is a supported schema extension type in Azure AD.

- **Target objects of extension**: Lists the target objects for the schema extension. A schema extension can be extended to multiple target object classes. For example, if you have a schema extension called Title, it can be extended to a User and Group object classes.

NOTE: After adding the schema extension attribute, add the application attribute name to the driver filter in the following format:

```
extension_<client_id>_<attribute_name>
```

where `<client_id>` indicates the client ID that is used by the driver to connect to Azure AD.

For example, `extension_4691ac9cbee390e6e8e_Title`.

Subscriber Options: To view the Subscriber options, select Show.

Truststore file: Specify the name and path of the truststore file containing the trusted certificates used when a remote server is configured to provide server authentication. This file will contain certificates for Azure Graph and Exchange Service. For example, `c:\security\truststore`.

Proxy Host and Port: When an HTTP proxy is used, specify the host address and the host port. For example, `192.10.1.3:18180`. Otherwise, leave the field blank.

Exchange and Powershell Service: When Identity Manager Exchange Service is enabled, the driver synchronizes Exchange users and groups using this service.

Exchange Service URL: Specify the URL of the Identity Manager Exchange Service.

For example, `https://<ip-addr>:<port>/ExchServer`.

Office 365 Exchange Online: To initiate a connection with Exchange Online and synchronize Office 365 exchange users and groups, select Yes.

Queue Operations: To enable queuing of objects when synchronizing between Azure AD and Identity Manager Exchange Service, select True.
**Page Size**: Set a value for the number of results displayed per page during Exchange Publisher poll.

**Trace location**: Specify the custom path where you want to save the Identity Manager Exchange Service logs. By default, the logs will be saved in this component’s installation directory.

**Trace Level**: Set the trace level for the Identity Manager Exchange Service.

The driver supports five trace levels: NOTIFY, INFO, ERROR, MORE INFO, and DEBUG. The default trace level is NOTIFY. The next trace level, that is, INFO provides basic trace messages. ERROR provides some additional information than the previous level. Detailed messages are logged if you select INFO. DEBUG logs information on debugging data along with detailed messages.

**Trace File Size Limit**: Specify the trace file size limit in MB. The minimum value is 10 MB.

**Database Password**: Specify the database password. The driver uses this password to encrypt and connect to the Publisher cache. Ensure that the same password is used to reconnect to the cache at a later time.

**Publisher Options**: To view the Publisher options, select Show.

**Enable Publisher**: Allows you to enable or disable the Publisher connection for the driver.

**Publisher Polling Interval**: Specify a time period after which the driver should query Azure AD for new changes. The time is specified in minutes.

**Heart Beat Interval**: Allows the driver to send a periodic status message on the Publisher channel when there is no traffic for a specific duration. This indicates the time period at which the heart beat document is issued by the driver shim. The time is specified in minutes.

10 On the **Remote Loader** page, fill in the following fields to configure the driver to connect using the Remote Loader, then click **Next**:

- **Connect to Remote Loader**: By default, the driver is configured to connect using the Remote Loader. Click **Next** to continue. Otherwise, fill in the remaining fields to configure the driver to connect using the Remote Loader.

- **Host Name**: Specify the hostname or IP address of the server where the driver’s Remote Loader service is running.

- **Port**: Specify the port number where the Remote Loader is installed and running. The default port number is 8090.

- **KMO**: Specify the Key Name of the Key Material Object (KMO) that contains the keys and certificate the Remote Loader uses for an SSL connection. This parameter is only used when you use SSL for connections between the Remote Loader and the Identity Manager engine.

- **Other Parameters**: Specify any other parameters required to connect to the Remote Loader. Any parameters specified must use a key-value pair format, as follows: `paraName1=paraValue1 paraName2=paraValue2`

- **Remote Password**: Specify the Remote Loader’s password as defined on the Remote Loader. The Identity Manager server (or Remote Loader) requires this password to authenticate to the Remote Loader.

- **Driver Password**: Specify the driver object password that is defined in the Remote Loader service. The Remote Loader requires this password to authenticate to the Identity Manager server.

11 On the **Azure AD Base** page, fill in the following fields, then click **Next**:

- **Domain Name**: Specify the Azure AD domain site context. For example, `<domain name>.onmicrosoft.com` or `<domain name>.com` format.
• **Identities to be synchronized:** Specify whether the driver should synchronize identities from AD or configure the Identity Vault to act as the identity provider. If you choose to configure the Identity Vault as an identity provider, association to any other directory is not required. When you choose to synchronize identity from AD, you can synchronize only users that have an association with AD. If you are using the driver in hybrid mode, select only AD option. This enables the driver to synchronize the identities from the Identity Vault to AD from where the identities will be synchronized to Azure AD cloud through Azure AD Connect.

• **Usage Location:** Specify the two letter country code for the user availing the Office 365 services.

12 (Conditional) On the **Install Azure AD Managed System Information** page, fill in the following fields to define the ownership of Azure AD, then click Next:

**General Information**

• **Name:** Specify a descriptive name for the managed system.

• **Description:** Specify a brief description of the managed system.

• **Location:** Specify the physical location of the managed system.

• **Vendor:** Select the vendor of the managed system.

• **Version:** Specify the version of the managed system.

**System Ownership**

• **Business Owner** - Select a user object in the Identity Vault that is the business owner of Azure AD. This can only be a user object, not a role, group, or container.

• **Application Owner:** Select a user object in the Identity Vault that is the application owner of Azure AD. This can only be a user object, not a role, group, or container.

This page is only displayed if you selected to install the Data Collection packages and the Account Tracking packages.

**System Classification**

• **Classification:** Select the classification of Azure AD. This information is displayed in the reports. The options are as follows:
  • Mission-Critical
  • Vital
  • Not-Critical
  • Other

  If you select **Other**, you must specify a custom classification for Azure AD.

• **Environment:** Select the type of environment Azure AD provides. The options are as follows:
  • Development
  • Test
  • Staging
  • Production
  • Other

  If you select **Other**, you must specify a custom environment for Azure AD.
13 On the Azure AD Password Synchronization page, fill in the following fields, then click Next:
   • **Set Password Never Expires:** If you set this option to True on the newly created users, the password does not expire for those users.
   • **Disable Force Change Password at First Login:** If you set this option to True, a user is not prompted to change the password when the user logs in to Azure AD for the first time.
   • **Set Strong Password Required:** If you set this option to True, the user needs to set a strong password.

14 On the Account Tracking page, specify the name of the realm, security domain, or namespace in which the account name is unique. You must set the Realm to the Azure AD domain name.

15 On the Confirm Installation Tasks page, review the summary of tasks and click Finish.

The driver is now created. You can modify the configuration settings by Configuring the Driver.

### Configuring the Driver

There are many settings that can help you customize and optimize the driver. The settings are divided into categories such as Driver Configuration, Engine Control Values, and Global Configuration Values (GCVs). Although it is important for you to understand all of the settings, your first priority should be to review the Driver Parameters located on the Driver Configuration page and the Global Configuration Values. These settings must be configured properly for the driver to start and function correctly. You can configure the driver with entitlements or with entitlements disabled.

To edit the properties, perform the following steps:

1. Open your project.
2. In the modeler, right-click the driver icon or the driver line, then select Properties.
3. Select Driver Configuration and configure the configuration properties.
4. Click GCVs > Entitlements and review the following settings:

   **NOTE:** These settings are only displayed if you installed the Entitlements package. If you selected the Azure AD Hybrid Entitlements package, only Roles and License entitlements are supported with this package.

   • **Use User Account Entitlement:** Ensure the value of this parameter is set to true to enable the driver to manage user account permissions using the User Account entitlement. By default, the value is set to True.
   
   • **Use Group Entitlement:** Ensure the value of this parameter is set to true to enable the driver to manage group memberships using the Group entitlement. By default, the value is set to True.

   **IMPORTANT:** If the values for Use User Account Entitlement and User Group Entitlement parameter is set to False, user and group membership synchronization is managed using the non-entitlement configuration method.

   • **Use License Entitlement:** Ensure the value of this parameter is set to true to enable the driver to manage licenses using the License entitlement. By default, the value is set to True.
   
   • **Use Roles Entitlement:** Ensure the value of this parameter is set to true to enable the driver to manage roles using the Roles entitlement. By default, the value is set to True.

5. Click Apply.
6. Modify any other settings as necessary.
In addition to the driver settings, you should review the set of default policies and rules provided by the basic driver configuration. Although these policies and rules are suitable for synchronizing with Azure AD, your synchronization requirements for the driver might differ from the default policies. If this is the case, you require customization.

7 Click OK when finished.
8 Continue with “Deploying the Driver” on page 33.

Deploying the Driver

After a driver is created in Designer, it must be deployed into the Identity Vault.

1 In Designer, open your project.
2 In the Modeler, right-click the driver icon, then select Live > Deploy.
3 If you are authenticated to the Identity Vault, skip to Step 5; otherwise, specify the following information:
   - **Host**: Specify the IP address or DNS name of the server hosting the Identity Vault.
   - **Username**: Specify the DN of the user object used to authenticate to the Identity Vault.
   - **Password**: Specify the user’s password.
4 Click OK.
5 Read through the deployment summary, then click Deploy.
6 Click OK.
7 Click Define Security Equivalence to assign rights to the driver.
   The driver requires rights to objects within the Identity Vault. The Admin user object is most often used to supply these rights. However, you might want to create a user account called DriversUser. Whatever rights that the driver needs to have on the server, the DriversUser object must have the same security rights.
   - 7a Click Add, then browse to and select the object with the correct rights.
   - 7b Click OK twice.
8 Click Exclude Administrative Roles to exclude users that should not be synchronized.
   You should exclude any administrative User objects (for example, Admin and DriversUser) from synchronization.
   - 8a Click Add, then browse to and select the user object you want to exclude.
   - 8b Click OK.
   - 8c Repeat Step 8a and Step 8b for each object you want to exclude.
   - 8d Click OK.
9 Click OK.
Starting the Driver

When a driver is created, it is stopped by default. Identity Manager is an event-driven system and will start caching events as soon as the driver is deployed. These cached events will be processed once the driver is started.

To start the driver:

1. In Designer, open your project.
2. In the Modeler, right-click the driver icon, then select Live > Start Driver.

Activating the Driver

The Identity Manager driver for Office 365 and Azure AD is part of the Identity Manager Integration Module for Microsoft Enterprise.

This integration module requires a separate activation. After purchasing the integration module, you will receive activation details in your NetIQ Customer Center.

If you create the driver in a driver set that has not been previously activated with this integration module, the driver will run in the evaluation mode for 90 days. You must activate the driver with this integration module during the evaluation period; otherwise, the driver will be disabled.

If driver activation has expired, the trace displays an error message indicating that you need to reactivate the driver to use it. For information on activation, refer to Activating Identity Manager in the NetIQ Identity Manager Overview and Planning Guide.
Upgrading an Existing Driver

The following sections provide information to help you upgrade an existing driver:

- “What’s New” on page 35
- “Working with MapDB 3.0.5” on page 35
- “Upgrading the Driver” on page 36

What’s New

What’s New in Version 5.1.1.0

This version of the driver does not provide any new features.

What’s New in Version 5.1.0.0

Identity Manager 4.7 provides support for MapDB 3.0.5. To ensure that your driver works correctly with Identity Manager 4.7 engine, see Working with MapDB 3.0.5.

Working with MapDB 3.0.5

NetIQ recommends that you review the following sections before upgrading your driver to work with Identity Manager 4.7 engine:

- “Understanding Identity Manager 4.7 Engine Support for Driver Versions” on page 35
- “Manually Removing the MapDB Cache Files” on page 36

Understanding Identity Manager 4.7 Engine Support for Driver Versions

- Drivers shipped with Identity Manager 4.7 are compatible with Identity Manager 4.7 Engine or Remote Loader. You must perform the following actions to complete the driver upgrade:
  1. Upgrade the Identity Manager Engine.
  2. (Conditional) Upgrade the Remote Loader.
  3. Upgrade the driver.
  4. Manually remove the MapDB state cache files from the Identity Vault’s DIB directory. For more information, see “Manually Removing the MapDB Cache Files” on page 36.
- Drivers shipped before Identity Manager 4.7 are not compatible with Identity Manager 4.7 Engine or Remote Loader.
Drivers shipped with Identity Manager 4.7 are not backward compatible with Identity Manager 4.6.x Engine or Remote Loader.

Drivers shipped with Identity Manager 4.7 are not backward compatible with Identity Manager 4.5.x Engine or Remote Loader.

Manually Removing the MapDB Cache Files

The Identity Manager engine upgrade process removes the existing MapDB driver work cache files (dx*) from the Identity Vault's DIB directory (/var/opt/novell/eDirectory/data/dib or C:\Novell\NDS\DIBFiles). You must manually remove the existing MapDB state cache files for the driver after upgrading the driver. The MapDB state cache files for the Azure AD driver are represented in the following format:

<Azure driver name>_obj.db.*

where * is the name of the state cache file for the driver. For example, <Azure driver name>_obj.db.t or <Azure driver name>_obj.db.p

This action ensures that your driver works correctly with Identity Manager 4.7 engine.

Upgrading the Driver

The driver upgrade process involves upgrading the installed driver packages and updating the existing driver files. These are independent tasks and can be separately planned for a driver. For example, you can update the driver packages and choose not to update the driver files at the same time. However, you are recommended to complete all the update steps within a short amount of time to ensure that the driver has the latest updates.

- "Upgrading the Installed Packages" on page 36
- "Updating the Driver Files" on page 37

Before starting the upgrade process, ensure that you have taken a back-up of the current driver configuration.

Upgrading the Installed Packages

1. Download the latest available packages.

   To configure Designer to automatically read the package updates when a new version of a package is available, click Windows > Preferences > NetIQ > Package Manager > Online Updates in Designer. However, if you need to add a custom package to the Package Catalog, you can import the package .jar file. For more information about creating custom packages, see Developing Packages in the NetIQ Designer for Identity Manager Administration Guide.

2. Upgrade the installed packages.

   2a. Open the project containing the driver.

   2b. Right-click the driver for which you want to upgrade an installed package, then click Driver > Properties.

   2c. Click Packages.

      If there is a newer version of a package, there is a check mark displayed in the Upgrades column.

   2d. Click Select Operation for the package that indicates there is an upgrade available.
2e From the drop-down list, click Upgrade.

2f Select the version that you want to upgrade to, then click OK.

NOTE: Designer lists all versions available for upgrade.

2g Click Apply.

2h (Conditional) Fill in the fields with appropriate information to upgrade the package, then click Next.

Depending on which package you selected to upgrade, you must fill in the required information to upgrade the package.

2i Read the summary of the packages that will be installed, then click Finish.

2j Review the upgraded package, then click OK to close the Package Management page.

For detailed information, see the Upgrading Installed Packages in the NetIQ Designer for Identity Manager Administration Guide.

Updating the Driver Files

This section provides general instructions for updating the driver files. For information about updating the driver files to a specific version, search for that driver patch in the Patch Finder Download Page and follow the instructions from the Readme file that accompanies the driver patch release.

To update the driver files:

1 Stop the driver instance by using iManager, Designer, or dxcmd by performing one of the following actions:
   - If the driver is running locally, stop the driver instance and the Identity Vault.
   - If the driver is running with a Remote Loader instance, stop the driver and the Remote Loader instance.

   For example, go to a command prompt on Linux and run ndsmanage stopall

2 Download the driver patch file to a temporary folder on your server.

3 Extract the contents of the driver patch file.

4 Update the driver files:
   - **Linux**: Open a command prompt and run the following command to upgrade the existing RPM:
     
rpm -Uvh <Driver Patch File Temporary Location>/linux/netiq-DXMLRESTAzure.rpm
   
   - **Windows**: Navigate to the <Extracted Driver Patch File Temporary Location>\windows folder and perform the following actions:
     
     - Copy the DXMLRESTAzureConfig.jar and DXMLRESTAzureShim.jar files to <IdentityManager installation>\NDS\lib or <IdentityManager installation>\RemoteLoader<architecture>\lib folder.
     
     - Copy the DXMLRESTAzureUtil.jar file to <IdentityManager installation>\DirXMLUtilities\restazure\util folder.

5 (Conditional) If the driver is running locally, start the Identity Vault and the driver instance.

   For example, open a command prompt on Linux and run ndsmanage startall

6 (Conditional) If the driver is running with a Remote Loader, start the Remote Loader and the driver instance.
The driver communicates over SSL with Azure AD and Identity Manager Exchange Service.

**IMPORTANT:** The connection accepts certificates only from a Java keystore. Make sure that the keystore for the certificates is a Java keystore.

The following sections provide instructions for creating a secure connection:

- “Securing Communication with Azure AD Graph” on page 39
- “Securing Communication with Identity Manager Exchange Service” on page 40

### Securing Communication with Azure AD Graph

To set up SSL between the driver and Azure AD graph REST endpoints, perform the following steps:

1. Open the following URL from your browser:
   ```
   https://graph.windows.net/
   ```
2. Obtain the public certificate and import it into the keystore.
   
   For example, if you are using Mozilla Firefox, perform the following steps:
   
   2a. In the address bar, click 🗝 and then click ➔ next to graph.windows.net.
   2b. Select Certificate (Valid). The certificate is displayed.
   2c. Click Certification Path. The Certification Path displays the hierarchical structure of the structure of all the certificates.
   2d. Select the root certificate (the top most parent certificate), and click View Certificate. The root certificate is displayed.
   2e. To save the certificate to your system, click Details > Copy to File > Next > Next.
   2f. Enter a filename for the certificate and save it to a location as required.
   2g. Add the exported key to the driver keystore using the following Java keytool command:

   ```
   keytool -import -file <path to the graph cert file>\<certname.crt> -keystore <mykeystore> -alias <aliasname>
   ```

   For example: `keytool -import -file azuread.crt -keystore azuread.jks -alias azuread`.

**NOTE**

- Ensure to place the new keystore in IDM Server. In case of Remote Loader place the keystore file in the system where the Azure AD driver is running.
- Ensure that you follow the above steps to import all the certificates into the keystore.
Securing Communication with Identity Manager Exchange Service

To set up SSL between the driver and Identity Manager Exchange Service, you need to create and import a server certificate into the root certificate store of the Windows server where the service is deployed. The following procedure assumes eDirectory as the Certificate Authority (CA).

1 Create a server certificate.
   1a In iManager, log in to the connected eDirectory server with administrator rights.
   1b Click Roles and Tasks > NetIQ Certificate Server > Create Server Certificate.
   1c Select the server and provide a nickname for the certificate.
      The nickname is same that you specified for Certificate Alias (example azuread as shown in previous section) while installing Identity Manager Exchange Service.
   1d Click Next, then click Finish to complete the certificate creation.

2 Export the server certificate from the connected eDirectory server and save it to a file in the pfx format.
   2a In iManager, log in to the connected eDirectory server with administrator rights.
   2b Click Roles and Tasks > NetIQ Certificate Access > Server Certificates, then select any server certificate.
   2c Click Export.
   2d Select the certificate by nickname and select Export Private Key.
   2e Enter the password and click Next.
   2f To save the certificate to a file, click Save the exported certificate.

3 Import the certificate to the trusted store of the Windows server on which you will run Identity Manager Exchange Service.
   3a Copy the .pfx file to the Windows server.
   3b Click Start > Run> mmc.
   3c Click File > Add/Remove Snap-in.
   3d Select Certificates and click Add to import this snap-in by choosing Computer account.
   3e Click Finish.
   3f Navigate to Certificates > Trusted Root Certification Authorities.
   3g Right-click and then select All Tasks > Import.
   3h On the Welcome to the Certificate Import Wizard page, click Next.
   3i Click Browse and select the eDirectory certificate you exported in Step 2.
   3j Specify the password and click Next.
   3k Click Finish to import the certificate into the trust store.

4 Start Identity Manager Exchange Service. For more information, see “Verifying and Starting the Identity Manager Exchange Service” on page 24.

5 Open the following Exchange service URL from your browser:
   https://<Exchange_Service>:Port/ExchServer

6 Obtain the public certificate and import it into the same keystore which was created and placed in IDM Server as mentioned in Step 2g on page 39 (for example, the keystore azuread as shown in the example for the Azure graph endpoint).
For example, perform the following steps to obtain a public certificate on Google Chrome:

6a Click 🔄 from the address bar and then click Details.
6b In the Security tab, click View Certificate.
6c In the Details tab, click Copy to File.
6d In the Certificate Import Wizard, click Next.
6e Select DER encoded binary and click Next.
6f Click Browse and navigate to the directory where you want to save the certificate.
6g Specify a name for the certificate and click Next.
6h Click Finish to complete the export.
6i Add the exported key to the driver keystore by using the following Java keytool command:

```
keytool -import -file <path to the exchange cert file>\<certname.cer> -keystore <mykeystore> -alias <aliasname>
```

**NOTE:** Ensure the keystore alias names are different for Azure AD Graph and the Exchange Service.
6 Transitioning from Existing Office 365 Driver to New Azure AD Driver

The Identity Manager driver for Office 365 and Azure Active Directory introduces significant architectural changes over the existing Office 365 driver. The driver provides the same and more functionality through an improved design that is more efficient and easier to configure. To learn more about the new architecture, see “Understanding How the Driver Works” on page 11.

Given these changes, in order to use the new driver, you need to migrate users and groups from Office 365 to Azure AD. The following sections help you accomplish this:

- “Preparing for Migrating Identities from Azure AD to Identity Vault” on page 43
- “Migrating Identities” on page 43
- “Transitioning Assignments Through User Application” on page 44

Preparing for Migrating Identities from Azure AD to Identity Vault

NetIQ recommends that you perform the migration in a test environment similar to your production environment before upgrading the production systems.

Before you begin, ensure that the following prerequisites are met:

- Turn off Exchange service and entitlements before starting the migration.
- Ensure that there is a valid matching attribute for user and group objects in the Identity Vault. You need to create a matching policy that includes a matching attribute so that you can do a one-to-one mapping. When a match is found, an association is created. For example, the `cn` attribute for a user in the Identity Vault is mapped to `UserPrincipalname` attribute in Azure AD. Similarly, the `cn` attribute for a group in Identity Vault is mapped to `displayName` attribute in Azure AD.

Migrating Identities

This process involves migration of all users and groups from Azure AD into the Identity Vault.

1. In iManager, click Identity Manager > Identity Manager Overview.
2. Browse to and select the driver set.
3. Click the Azure AD driver icon.
4. In the Identity Manager Driver Overview page, select Migrate and then Migrate into Identity Vault.

   **NOTE:** You cannot perform a wildcard search to query users and groups for migration. You must select the user or group class to migrate.

5. In the Edit List window, select User class and click OK.
   Similarly, to migrate Azure AD groups, select Groups class and click OK.
Transitioning from Existing Office 365 Driver to New Azure AD Driver

This process will also update the association for the migrated objects.

Transitioning Assignments Through User Application

As there are significant architectural changes between the existing Office 365 driver and the Azure AD driver, you need to recreate the existing Office 365 resources in the Azure AD driver. The following considerations apply while transitioning the existing Office 365 assignments to the Azure AD driver:

Recreate the Office 365 driver resources for the Azure AD driver

You can use the existing Office 365 resources as a reference to create the resources manually and then map them appropriately to the existing Office 365 roles. For example, you have an existing role in Identity Applications called IT_Admin_O365_Role and the role is mapped to O365_MailboxAdmin, O365_SecurityAdmin, and O365_SharePointServiceAdmin resources. To transition the role assignments from existing Office 365 driver to Azure AD driver, you need to create similar resources for the Azure AD driver and then map them appropriately to existing IT_Admin_O365_Role role. For more information about creating roles and resources, see Creating and Managing Roles in the NetIQ Identity Manager - Administrator’s Guide to the Identity Applications.

The following procedure explains how to create a new resource in Azure AD, assign an entitlement value to the resource, and map the resource to an existing Office 365 role in Identity Applications.

To create Azure AD resource and assign an entitlement value to the resource:

1. Turn on entitlements for the Azure AD driver.
2. Create a new resource.
   - Open a Web browser and log in to Identity Applications. For example: http://myappserver:8543/idmdash/
3. Go to Administration > Resources and click the + icon.
4. Select With entitlement.
5. In Entitlement or Driver list, select the Azure AD driver.
6. In Entitlement Association, select Mailbox Administrator from the list.
7. Click Create Resource.
8. Specify the required values such as Resource Name and Resource Description to create a new resource with entitlement for the Azure AD driver. Click Apply.

You must also create resources for other roles. For example, Security Admin, and SharePointService Admin.

To map the newly created resource to an existing Office 365 role:

1. Go to Administration > Roles.
2. Select the Office 365 role from the list. For example, IT_Admin_O365_Role.
3. Select Map Resource to Role.
4. In Available for Mapping > Resources, drag and drop the newly created Azure AD resource to Mapped Resources.
5. (Conditional) If a resource request form is configured, specify the necessary information and click Apply.
6. Specify the Mapped Description and click Apply.
Manually assign permissions on the newly created resources

If you have resources with direct assignments (resources not mapped to any role), then manually assign the permissions appropriately on the newly created resources for the Azure AD driver. Go to Administration > Resources, and:

1. Go to Administration > Resources.
2. Select the newly created Azure AD resource.
3. select Resource Assignments.
4. Click + to assign to the required users in the system.
Identity Manager Exchange Service is a REST-based Windows service to support Exchange Online. The Azure AD driver leverages this service to provision or deprovision user mailboxes, mail users, create or remove distribution lists and security groups on Office 365 Exchange Online. This service converts the driver REST calls to Exchange Online cmdlets to manage Exchange Online.

When the Azure AD driver starts, it initializes the service by sending information to Office 365 such as exchange domain, user name, and password. The Azure AD driver is properly initialized only if the system time is synchronized between the servers running the driver and the Exchange Online service.

The schema includes the following attributes to support Office 365 Exchange Online:

- **DirXML-AADObjectType:** Contains the type for a user or a group object.
  
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UserMailbox</td>
<td>Creates a mailbox user in Exchange Online</td>
</tr>
<tr>
<td>MailUser</td>
<td>Creates a mail user in Exchange Online</td>
</tr>
<tr>
<td>Distribution</td>
<td>Creates a distribution group in Exchange Online</td>
</tr>
<tr>
<td>Security</td>
<td>Creates a security group in Exchange Online</td>
</tr>
<tr>
<td>UnifiedGroup</td>
<td>Creates a Office 365 group in Exchange Online</td>
</tr>
</tbody>
</table>

  For example, to add a mail user, set the **DirXML-AADObjectType** attribute to MailUser. To create an Exchange group, set this attribute to Distribution or Security.

- **DirXML-AADAArchiveStatus:** Contains the mailbox archive status for an Exchange Online user.

- **DirXML-AADLitigationHoldEnabled:** Contains the mailbox litigation hold status for an Exchange Online user.

- **DirXML-AADLegacyExchangeDN:** Contains the Exchange server DN for a mailbox.

If you are not using Exchange Online, these attributes are not required.

The service also supports execution of PowerShell cmdlets that are part of XDS as values of **psexecute** attribute.

PowerShell is a shell-based automation framework created by Microsoft that allows users to manage the internal functions of other Microsoft products, including Active Directory and Exchange. PowerShell uses special .NET classes called cmdlets to perform various processing actions on objects in your Active Directory or Exchange environments. Identity Manager can use PowerShell cmdlets to perform post-processing on events by sending the cmdlets to the Azure AD driver using policies.

**IMPORTANT:** The PowerShell commands should be wrapped in double quotes to pass a value to **psexecute**. Identity Manager uses double quotes, however PowerShell prefers single quotes.
For example:

```xml
<modify-attr attr-name="psexecute">
  <add-value>
    <value type="string">Get-Process</value>
  </add-value>
</modify-attr>
```

**NOTE:** For PowerShell reference, use lowercase format. For example, `psexecute`.

For more information about PowerShell, see the following resources:

Troubleshooting

Refer to the following sections if you are experiencing a problem with the Azure AD driver.

- “Synchronizing country and usageLocation Attributes” on page 49
- “Azure AD Password Complexity” on page 50
- “Restoring the Driver to Current State” on page 50
- “No Trusted Certificate Found Exception” on page 50
- “Exchange Error During Driver Restart” on page 50
- “Setting the set-executionPolicy to RemoteSigned in the Powershell” on page 51
- “Email Address is Set Incorrectly for Groups that are Provisioned to a Different Valid Domain” on page 51
- “Revoking Roles and Licenses in Hybrid Mode” on page 51
- “Setting Primary SMTP Address With EmailAddress Attribute Displays An Error” on page 51
- “Mapping company Attribute with companyName Attribute Displays An Error” on page 51
- “Issue with the Size of PowerShell Log File” on page 52
- “License Dependency in Developer Pack” on page 52
- “User Name Cannot Contain Some Special Characters” on page 52
- “Restoring a Mailbox or Mail User Displays a Warning Message” on page 52
- “Random Errors While Connecting to the Exchange Portal” on page 52
- “Adding a Graph User to Group Fails” on page 53
- “No Trusted Certificate Found Exception” on page 53
- “Driver Fails to Connect to Microsoft Graph API Due to Invalid Certificate Error” on page 53
- “Driver Fails to Connect to Office 365 due to the MS Exchange License Issues” on page 54

Synchronizing country and usageLocation Attributes

You can set the following attributes while using eDirectory to select a country for a user:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Mapped with usageLocation attribute of Azure AD. It contains a two-character country code as defined by the ISO.</td>
</tr>
<tr>
<td>co</td>
<td>Mapped with country attribute of Azure AD. It contains a longer name for the country.</td>
</tr>
</tbody>
</table>

Since the ISO-defined character country codes are intended to be used by the Azure AD licenses, the default schema in the Identity Vault includes co and C attributes.
Azure AD Password Complexity

Passwords must adhere to the Azure AD password requirements. A user cannot be added if the specified password does not meet these requirements.

Complexities and requirements in Azure AD password policies are different from complexities and requirements in eDirectory. If you plan to use password synchronization, create and use passwords that match the rules of complexity in both Azure AD and eDirectory.

For information about Azure AD password complexity requirements, see “Password must meet complexity requirements”.

For information about managing passwords in eDirectory, see the Password Management Administration Guide.

TIP: Make the password policies for both Identity Vault and Azure AD similar to each other as you can. In a lab environment, disable strong-password functionality on Azure AD before installing the Azure AD driver. After the driver is working properly, make sure that passwords used in eDirectory and Azure AD satisfy the rules of complexity for both systems. Then re-enable strong-password functionality on Azure AD.

Restoring the Driver to Current State

If you need to reset the Publisher state of the driver to prevent the driver from picking up interim events and performing unwanted actions on the Identity Vault, perform the following steps after stopping the driver.

1. Delete the Dirxml-DriverStorage attribute on the driver object in the Identity Vault.
2. If the driver is remotely loaded, delete the state file from the Remote Loader server.
3. Set the driver to Manual or Automatic startup.
4. Start the driver.

No Trusted Certificate Found Exception

This issue occurs when the certificate is changed at the Azure Graph endpoint.

To workaround this issue, import the new public certificate into the trust store of the driver. For more information, see “Securing Communication with Azure AD Graph” on page 39.

Exchange Error During Driver Restart

Except the case of invalid credentials, when the driver fails to connect to MSOL, the driver makes three attempts to connect to MSOL with an interval of 30 seconds after each attempt.

If the driver fails to connect to MSOL after three attempts, the driver shuts down.
Setting the set-executionPolicy to RemoteSigned in the Powershell

The set-ExecutionPolicy cmdlet enables you to determine the PowerShell scripts that can be run on your computer.

By default, set-ExecutionPolicy is set to Restricted. To start the driver, change the setting to RemoteSigned in PowerShell. Otherwise, the driver fails to start and displays an error message.

Email Address is Set Incorrectly for Groups that are Provisioned to a Different Valid Domain

When you configure the driver to a different valid domain and add an exchange group on the Subscriber channel, the email address is set incorrectly for the group on the exchange portal.

Workaround: Add PrimarySmtpAddress to the driver filter and add PrimarySmtpAddress for the group on the Subscriber channel.

Revoking Roles and Licenses in Hybrid Mode

When the Azure AD driver is running in a hybrid mode and a user’s account permission is revoked using the AD driver, the account is either disabled or deleted in AD and the corresponding association is removed from the Identity Vault. This action also triggers AAD Connect to disable or delete the user from Azure AD. However, this action does not revoke user’s Roles and License assignments in the User Application.

Workaround: Manually remove the Roles and License assignments for the user from the User Application.

Setting Primary SMTP Address With EmailAddress Attribute Displays An Error

When you set the primary SMTP address from EmailAddress attribute, an error message is displayed.

Workaround: To synchronize the primary SMTP address, create a custom attribute in eDirectory and map it with the PrimarySmtpAddress attribute.

Mapping company Attribute with companyName Attribute Displays An Error

The driver does not allow mapping the company attribute with the companyName attribute and reports an error.

Workaround: Change the application’s attribute name from companyName to Company. The Azure AD driver treats companyName as an Azure Graph API attribute and Company as an exchange attribute.
Issue with the Size of PowerShell Log File

By default, the PowerShell log file is located at \AppData\Local\Microsoft\Office365\Powershell. When you execute MSOnline cmdlets in the Exchange service, the log file increases in size.

Workaround: To prevent the logs from getting included in the file, restrict the rights to the directory containing the log file.

License Dependency in Developer Pack

The Office 365 portal does not allow you to revoke an individual license if it has a dependency on other licenses. For example, an individual license is dynamically allocated to a resource in the User Application.

To workaround this issue, remove the dependent licenses before attempting to revoke the individual license. For example, if Office Online for Developer license is dependent on SharePoint Online for Developer license, you need to revoke Office Online for Developer license before you revoke SharePoint Online for Developer license.

User Name Cannot Contain Some Special Characters

While adding a user, if the user name includes some special characters that Azure AD does not support in userprincipalname, the user addition fails with an error. For details about the characters that are not supported, see the Microsoft web site.

You can customize your policies to remove the unsupported characters from the attributes.

Restoring a Mailbox or Mail User Displays a Warning Message

When you restore a mailbox or mail user, the following message is displayed:

Operation Failed: Get-User: The operation couldn't be performed because object couldn't be found

This issue does not cause any functionality loss. You can ignore the message and continue with restoring the mailbox or mail user.

Random Errors While Connecting to the Exchange Portal

You might encounter the following errors while connecting to the Exchange portal:

Driver fails to connect to the Exchange portal

The driver shuts down with the following error message.

There was no endpoint listening that could accept the message.

This issue is observed when the Exchange portal is down.
**Workaround:** Start the driver when the Exchange portal is functional.

**Driver stops with a fatal error**

In iManager, when you modify any driver parameter and try to restart the driver, the driver shuts down with the following error message:

`IOException: graph.windows.net: Name or service not known`

**Workaround:** Start the driver when the Exchange portal is functional.

**Azure AD Cloud reports java.net.UnknownHostException: login.windows.net error**

This issue is randomly observed.

If you restart the driver, the driver displays the following error, when the Office 365 Exchange Online parameter is set to No and Publisher channel is disabled.

`java.net.UnknownHostException: login.windows.net`

This error is reported from Azure AD. As there is no functionality loss, start the driver after few minutes.

**Random Error Messages in Exchange Trace**

When you run the driver with Exchange Online enabled, error messages are reported in the Exchange trace. For example:

`publish: Operation Failed: Starting a command on the remote server failed with the following error message. The I/O operation has been aborted because of either a thread exit or an application request`

Ignore the error message as it does not cause any functionality loss.

**Adding a Graph User to Group Fails**

This issue is randomly observed.

To workaround this issue, delete the `DirXML-ApplicationSchema` attribute and restart the driver.

**No Trusted Certificate Found Exception**

A client certificate needs to be added to the driver’s Java keystore. For more information, see “Securing Communication with Identity Manager Exchange Service” on page 40.

**Driver Fails to Connect to Microsoft Graph API Due to Invalid Certificate Error**

Most Azure services get their SSL/TLS certificates from a known set of intermediate certificate authorities (CAs) that Microsoft operates. Microsoft publishes details of these CAs in its Certificate Practice Statement (CPS). The following CA’s have been recently introduced:

- Microsoft IT TLS CA 1
You must include the new CAs in the driver’s truststore file. Otherwise, the driver reports an invalid certificate exception in the trace.

To workaround this issue, perform the steps described in “Securing Communication with Azure AD Graph” on page 39. You must repeat the procedure for all the certificates generated by all the four CAs. After the certificates are imported into the truststore file, the Azure driver works properly.

The name of a certificate is specified by the 'Issued by' field of the certificate.

Microsoft keeps replacing the CAs that it uses to validate Azure Graph API (https://graph.windows.net/); therefore, you must refresh the browser every time the API is launched. In case a new certificate is available, you must download it.

**Driver Fails to Connect to Office 365 due to the MS Exchange License Issues**

**Explanation:** When you are configuring the Azure AD driver with Office 365, fatal connectivity errors are encountered due to issues of MS Exchange Licenses. The error message is shown below:

<status level="fatal">Error Connecting to Office365. [ps.outlook.com] Connecting to remote server ps.outlook.com failed with the following error message : The WinRM client received an HTTP status code of 403 from the remote WS-Management service. For more information, see the about_RemoteTroubleshooting Help topic.</status>

**Possible cause:** Certain issues with MS Exchange Licenses cause the driver to fail to connect and shuts down automatically.

**Solution:** You must configure the driver with an Azure account which has the Global Administrator role, and the appropriate subscriptions and licenses associated with it.
Driver Properties

This section provides information about the Driver Configuration and Global Configuration Values properties for the Azure AD driver. These are the only unique properties for drivers. All other driver properties (Named Password, Engine Control Values, Log Level, and so forth) are common to all drivers.

The information is presented from the viewpoint of iManager. If a field is different in Designer, it is marked with a Designer icon.

- "Driver Configuration" on page 55
- "Global Configuration Values" on page 59

Driver Configuration

In iManager:

1. Click to display the Identity Manager Administration page.
2. Open the driver set that contains the driver whose properties you want to edit:
   2a. In the Administration list, click Identity Manager Overview.
   2b. Click the Driver Sets tab.
   2c. If the driver set is not listed on the Driver Sets tab, use the Search In field to search for and display the driver set.
   2d. Click the driver set to open the Driver Set Overview page.
3. Locate the driver icon, then click the upper right corner of the driver icon to display the Actions menu.
4. Click Edit properties to display the driver’s properties page.
   By default, the Driver Configuration page is displayed.

In Designer:

1. Open a project in the Modeler.
2. Right-click the driver line, then click Properties.
3. Click Driver Configuration.

The Driver Configuration options are divided into the following sections:

- "Driver Module" on page 56
- "Driver Object Password" on page 56
- "Authentication" on page 56
- "Startup Option" on page 57
- "Driver Parameters" on page 57
Driver Module

The driver module changes the driver from running locally to running remotely or the reverse.

Connect to Remote Loader: Used when the driver is connecting remotely to the connected system. The options are:

- **Java**: Specify the name of the Java class.
- **Native**: Specify the name of the DLL file. This option is not applicable to this driver.
- **Connect to Remote Loader**: Select this option to specify the remote loader client configuration.

  Designer includes one sub-option:

  - **Remote Loader client configuration for documentation**: Includes information on the Remote Loader client configuration when Designer generates documentation for the driver.

Driver Object Password

**Driver object password**: Use this option to set a password for the driver object. If you are using the Remote Loader, you must enter a password on this page or the remote driver does not run. This password is used by the Remote Loader to authenticate itself to the remote driver shim.

Authentication

The Authentication section stores the information required to authenticate to the connected system.

**Authentication ID**: Provide the authentication information while configuring the domain connections for the driver. This is a qualified userprincipalname on Azure AD with login permissions. For example, admin@domain.onmicrosoft.com

**Remote Loader connection parameters**: Used only if the driver is connecting to the application through the Remote Loader. The parameter to enter is hostname=xxx.xxx.xxx.xxx port=xxxx kmo=certificatename, when the hostname is the IP address of the application server running the Remote Loader server and the port is the port the Remote Loader is listening on. The default port for the Remote Loader is 8090.

The kmo entry is optional. It is only used when there is an SSL connection between the Remote Loader and the Identity Manager engine. For example, hostname=10.0.0.1 port=8090 kmo=IDMCertificate. Specify the additional parameters in the Other parameters field.

**Driver Cache Limit (kilobytes)**: Specify the maximum event cache file size (in KB). If it is set to zero, the file size is unlimited. select Unlimited option to set the file size to unlimited in Designer.

**Application Password**: Use the Set Password option to set the application authentication password.

**Remote Loader Authentication**: Used only if the driver is connecting to the application through the Remote Loader. The parameter to enter is hostname=xxx.xxx.xxx.xxx port=xxxx kmo=certificatename, when the hostname is the IP address of the application server running the Remote Loader server and the port is the port the Remote Loader is listening on. The default port for the Remote Loader is 8090.

The kmo entry is optional. It is only used when there is an SSL connection between the Remote Loader and the Identity Manager engine. For example, hostname=10.0.0.1 port=8090 kmo=IDMCertificate. Specify the additional parameters in the Other parameters field.
Remote loader password: Use this option to update the remote loader password.

**Startup Option**

The Startup Option section allows you to set the driver state when the Identity Manager server is started.

**Auto start:** The driver starts every time the Identity Manager server is started.

**Manual:** The driver does not start when the Identity Manager server is started. The driver must be started through Designer or iManager.

**Disabled:** The driver has a cache file that stores all of the events. When the driver is set to Disabled, this file is deleted and no new events are stored in the file until the driver state is changed to Manual or Auto Start.

If the driver is Disabled and then changed to Auto start or Manual, you can select the Do Not Automatically Synchronize the Driver check box. This prevents the driver from synchronizing objects automatically when it loads. To synchronize objects manually, use the Synchronize button on the Driver Overview page.

**Driver Parameters**

The Driver Parameters section lets you configure the driver-specific parameters. When you change driver parameters, you tune driver behavior to align with your network environment.

The driver setting parameters are divided into the following categories:

- “Driver Settings” on page 57
- “Driver Operation Mode” on page 57
- “Schema Extensions Configuration” on page 58
- “Subscriber Settings” on page 58
- “Publisher Settings” on page 59

**Driver Settings**

**Client ID:** Specifies the account name which the Azure AD driver will use to access the Azure AD applications. You need to set the level of permissions required by the driver.

**Client Secret:** Specifies the password for the client ID to access the Azure AD applications.

---

**NOTE:** For information on creating the Client ID and Client Secret for your application, see “Creating a Proxy Application on Azure AD” on page 20.

---

**Remove Existing Passwords:** Select this option to clear the existing password. You can enter a new password at this point.

---

**Driver Operation Mode**

**Enable Hybrid Operation Mode:** In hybrid mode, the driver supports only Roles and License entitlements. The users and groups are provisioned by the AD driver. By default, the parameter is set to Yes. If you want to run the driver in cloud-only mode, set the value to No and install the Azure AD Cloud Only Entitlements package.
Activate Azure Directory Roles: To activate the Azure AD roles, set this parameter to Yes. Azure AD driver will fetch only the roles that are already activated.

Schema Extensions Configuration

Show Schema Extensions Configuration: To show the schema extensions in the configuration wizard, select Show.

Existing Schema Extensions: To retain the previously-loaded configuration, select Preserve. However, when you select Preserve and add a new extension, the extension will be added. Select Remove to overwrite an existing configuration.

Add a schema extension: Add a schema extension and specify appropriate configuration details. You can add multiple schema extensions if required.

- Name of extension: Specify the name of the schema extension. If you create more than one schema extension with the same name, the first extension in the list will be used. The remaining extensions will be ignored.
- Type of extension: Indicates the data type for the configured schema extension. Ensure that the data type is a supported schema extension type in Azure AD.
- Target objects of extension: Lists the target objects for the schema extension. A schema extension can be extended to multiple target object classes. For example, if you have a schema extension called Title, it can be extended to a User and Group object class.

NOTE: You can configure a maximum of hundred extensions on Azure AD.

Subscriber Settings

Domain Name: Specify the Azure AD domain site context. For example, <domain name>.onmicrosoft.com or <domain name>.com format.

Truststore file: Specify the name and path of the truststore file containing the trusted certificates used when a remote server is configured to provide server authentication. This file will contain certificates for Azure Graph and Exchange Service. For example, c:\security\truststore.

Proxy Host and Port: When an HTTP proxy is used, specify the host address and the host port. For example, 192.10.1.3:18180. Otherwise, leave the field blank.

Set proxy authentication parameters: To set proxy authentication, select Show. and specify the user and password for proxy authentication.

Exchange and Powershell Service: When this service is enabled, the driver will synchronize Exchange users and groups using this service.


Refresh Deleted User Cache: When you set this parameter to Yes, the local cache that contains the deleted users is refreshed with the objects present in the Office 365 deleted user container.

Office 365 Exchange Online: To initiate a connection with Exchange Online and synchronize Office 365 exchange users and groups, select Yes.

Queue Operations: To enable queuing of objects when synchronizing between Azure AD and Identity Manager Exchange Service, select True.
**Page Size:** Set a value for the number of results per page during Exchange Publisher poll.

**Trace location:** Specify the custom path where you want to save the Identity Manager Exchange Service logs. By default, the logs will be saved in this component's installation directory.

**Trace Level:** Set the trace level for the Identity Manager Exchange Service. The driver supports five trace levels: NOTIFY, INFO, ERROR, MORE INFO, and DEBUG. The default trace level is NOTIFY. The next trace level, that is, INFO provides basic trace messages. ERROR provides some additional information than the previous level. Detailed messages are logged if you select INFO. DEBUG logs information on debugging data along with detailed messages.

**Trace File Size Limit:** Specify the trace file size limit. The value is measured in MB. The minimum value is 10 MB.

**Database Password:** Specify the database password. This password is used to encrypt and connect to the Publisher cache. Ensure that the same password is used to reconnect to the cache at a later time.

**Remove Existing Passwords:** Select this option to clear the existing password. You can enter a new password at this point.

**Publisher Settings**

**Enable publisher:** Allows you to enable or disable the Publisher connection for your Azure AD driver.

**Publisher Polling Interval:** Specify a time period after which Azure AD will be queried for new changes. The time is indicated in minutes.

**Heart Beat Interval:** Allows the driver to send a periodic status message on the Publisher channel when there has been no Publisher channel traffic for the given number of minutes. This indicates the time period at which the heart beat document is issued by the driver shim. The time is indicated in minutes.

**Global Configuration Values**

Global configuration values (GCVs) are values that can be used by the driver to control functionality. GCVs are defined on the driver or on the driver set. Driver set GCVs can be used by all drivers in the driver set. Driver GCVs can be used only by the driver on which they are defined.

The Azure AD driver includes several predefined GCVs. You can also add your own if you need additional ones as you implement policies in the driver.

To access the driver's GCVs in iManager:

1. Click ![ ] to display the Identity Manager Administration page.
2. Open the driver set that contains the driver whose properties you want to edit:
   2a In the Administration list, click Identity Manager Overview.
   2b If the driver set is not listed on the Driver Sets tab, use the Search In field to search for and display the driver set.
   2c Click the driver set to open the Driver Set Overview page.
3. Locate the Azure AD driver icon, click the upper right corner of the driver icon to display the Actions menu, then click Edit Properties.
To add a GCV to the driver set, click Driver Set, then click Edit Driver Set properties.

To access the driver’s GCVs in Designer:

1. Open a project in the Modeler.
2. Right-click the Azure AD driver icon or line, then select Properties > Global Configuration Values.

or

To add a GCV to the driver set, right-click the driver set icon, then click Properties > GCVs.

The global configuration values are organized as follows:

- “Password Synchronization” on page 60
- “Driver Configuration” on page 61
- “Account Tracking” on page 61
- “Exchange Role Entitlement” on page 62
- “Entitlements” on page 62
- “Managed System Information” on page 64

**Password Synchronization**

These GCVs enable password synchronization between the Identity Vault and the Azure AD system.

In Designer, you must click the icon next to a GCV to edit it. This displays the Password Synchronization Options dialog box for a better view of the relationship between the different GCVs.

In iManager, you should edit the Password Management Options on the Server Variables tab rather than under the GCVs. The Server Variables page has a better view of the relationship between the different GCVs.

**Connected System or Driver Name:** Specify the name of the Azure AD system or the driver name. This value is used by the e-mail notification template to identify the source of the notification message.

**Application accepts passwords from Identity Manager:** If True, allows passwords to flow from the Identity Manager data store to the connected system.

**Identity Manager accepts passwords from application:** If True, allows passwords to flow from the connected system to Identity Manager.

**Publish passwords to NDS password:** If True, uses the password from the connected system to set the non-reversible NDS password in eDirectory.

**Publish passwords to Distribution Password:** If True, uses the password from the connected system to set the NMAS Distribution Password used for Identity Manager password synchronization.

**Require password policy validation before publishing passwords:** If True, applies NMAS password policies during publish password operations. The password is not written to the data store if it does not comply.

**Reset user’s external system password to the Identity Manager password on failure:** If True, on a publish Distribution Password failure, attempt to reset the password in the connected system by using the Distribution Password from the Identity Manager data store.
Notify the user of password synchronization failure via e-mail: If True, notify the user by e-mail of any password synchronization failures.

Driver Configuration

The following GCVs contain configuration information for the Azure AD driver. They are divided into the following categories:

Synchronization Settings

Use the following GCVs to control how the driver is configured:

Office 365 settings

- Domain Name: Specify the Office 365 site context using the admincentral.onmicrosoft.com format.
- Identities to be synchronized: Specify whether the driver should synchronize identities from AD or configure the Identity Vault to act as the identity provider.
  If you choose to configure the Identity Vault as an identity provider, association to any other directory is not required.
  When you choose to synchronize identity from AD, you can synchronize only users that have an association with AD. If you are using the driver in hybrid mode, select only AD option. This enables the driver to synchronize the identities from the Identity Vault to AD from where the identities will be synchronized to Azure AD cloud through Azure AD Connect.
- Usage Location: Specify the two letter country code of the user availing Office 365 services.
- Enable Hybrid Operation Mode: If Yes, the driver will provision only Roles and License entitlements while the users and groups are provisioned by the AD driver. To run the driver in normal mode, set the option to No.

Account Tracking

Account tracking is part of Identity Reporting.

Enable Account Tracking: Set this to True to enable account tracking policies. Set it to False if you do not want to execute account tracking policies.

Realm: Specify the name of the realm, security domain, or namespace in which the account name is unique. You must set the Realm to the Office 365 Domain Name.

Object Class: Add the object class to track. Class names must be in the application namespace.

Identifiers: Add the account identifier attributes. Attribute names must be in the application namespace.

Status attribute: Specify the name of the attribute in the application namespace to represent the account status.

Status active value: Value of the status attribute that represents an active state.

Status inactive value: Value of the status attribute that represents an inactive state.
Subscription Default Status: Select the default status that the policies assume when an object is subscribed to the application and the status attribute is not set in the Identity Vault. The options are:

- Active
- Inactive
- Undefined
- Uninitialized

Publication Default Status: Select the default status that the policies assume when an object is published to the Identity Vault and the status attribute is not set in the application. The options are:

- Active
- Inactive
- Undefined
- Uninitialized

**Exchange Role Entitlement**

This entitlement is supported if you have upgraded to the 5.0.1 version of the driver. You need to import the Azure AD Exchange Role Entitlement package to use this entitlement.

**NOTE:** Before you use this entitlement, ensure that exchange service is running.

**Use Exchange Roles Entitlement:** Select True to enable the driver to manage exchange roles based on the driver's defined entitlements.

**Advanced Settings:** To enable the advanced settings such as data collection, role mapping, and resource mapping, select Show.

- **Allow data collection from exchange roles:** Select Yes if you want to allow data collection by Data Collection Service for exchange roles.
- **Allow role mapping of exchange roles:** Select Yes if you want to allow mapping of exchange roles in Identity Applications.
- **Allow resource mapping of exchange roles:** Select Yes if you want to allow mapping of exchange roles in Identity Reporting.
- **Exchange Role extensions:** The content of this field is added below the entitlement elements in the EntitlementConfiguration resource object.

**Entitlements**

There are multiple sections in the Entitlements tab. Depending on which packages you installed, different options are enabled or displayed.

- "Entitlements" on page 63
- "Data Collection" on page 63
- "Role Mapping" on page 63
- "Resource Mapping" on page 64
- "Entitlement Extensions" on page 64
Entitlements

**Use User Account Entitlement:** Entitlements act like an On/Off switch to control account access. Enable the driver for entitlements to create accounts, and remove/disable it when the account entitlement is granted to or revoked from users. If you select True, user accounts in Azure AD can be controlled by using entitlements.

**NOTE:** User Account Entitlement is supported in cloud-only mode. It is not supported in hybrid mode.

- **Enable Login Disabled attribute sync:** Specify whether the driver syncs the changes made to the Login Disabled attribute in the Identity Vault even if the User Account entitlement is enabled.
- **When account entitlement revoked:** Select the desired action in the Azure AD database when a User Account entitlement is revoked from an Identity Vault user. The options are Disable Account or Delete Account.

**Use Group Membership Entitlement:** Select True to enable the driver to manage Azure AD group membership based on the driver's Group entitlement.

Select False to disable management of group membership based on entitlement.

**Use License Entitlement:** Select True to enable the driver to manage licenses based on the driver’s defined entitlements. To assign multiple Azure AD licenses, you must create multiple resources on user application. This is required because an Azure AD license entitlement can have only single value.

**Use Roles Entitlement:** Select True to enable the driver to manage roles based on the driver’s defined entitlements. Select False to disable management of role assignments for users based on the entitlements.

Data Collection

Data collection enables Identity Reporting to gather information to generate reports.

**Enable data collection:** Select Yes to enable data collection for the driver through Data Collection Service by the Managed System Gateway driver. If you are not going to run reports on data collected by this driver, select No.

**Allow data collection from user accounts:** Select Yes to allow data collection by Data Collection Service for user accounts.

**Allow data collection from groups:** Select Yes to allow data collection by Data Collection Service through the Managed System Gateway driver for groups.

**Allow data collection from licenses:** Select Yes to allow data collection by Data Collection Service for licenses.

**Allow data collection from roles:** Select Yes to allow data collection by Data Collection Service for roles.

Role Mapping

Identity Applications allow you to map business roles with IT roles.

**Enable role mapping:** Select Yes to make this driver visible to Identity Applications.
Allow mapping of user accounts: Select Yes if you want to allow mapping of user accounts in the Identity Applications. An account is required before a role, profile, or license can be granted through Identity Applications.

Allow mapping of groups: Select Yes if you want to allow mapping of groups in Identity Applications.

Allow mapping of licenses: Select Yes if you want to allow mapping of licenses in Identity Applications.

Allow mapping of Exchange mailboxes: Select Yes if you want to allow mapping of roles in Identity Applications.

Resource Mapping

The Identity Applications allow you to map resources to users.

Enable resource mapping: Select Yes to make this driver visible to Identity Applications.

Allow mapping of user accounts: Select Yes if you want to allow mapping of user accounts in Identity Applications. An account is required before a role, profile, or license can be granted.

Allow mapping of licenses: Select Yes if you want to allow mapping of licenses in Identity Applications.

Allow mapping of Exchange mailboxes: Select Yes if you want to allow mapping of roles in Identity Applications.

Entitlement Extensions

User account extensions: The content of this field is added below the entitlement elements in the EntitlementConfiguration resource object.

Group extensions: The content of this field is added below the entitlement elements in the EntitlementConfiguration resource object.

License extensions: The content of this field is added below the entitlement elements in the EntitlementConfiguration resource object.

Role extensions: The content of this field is added below the entitlement elements in the EntitlementConfiguration resource object.

Managed System Information

These settings help Identity Reporting function to generate reports. There are different sections in the Managed System Information tab.

- “General Information” on page 64
- “System Ownership” on page 65
- “System Classification” on page 65
- “Connection and Miscellaneous Information” on page 65

General Information

Name: Specify a descriptive name for the managed system.

Description: Specify a brief description of the managed system.
**Location:** Specify the physical location of the managed system.

**Vendor:** Select Microsoft as the vendor of the managed system.

**Version:** Specify the version of the managed system.

**System Ownership**

**Business Owner:** Browse to and select the business owner in the Identity Vault for the connected application. You must select a user object, not a role, group, or container.

**Application Owner:** Browse to and select the application owner in the Identity Vault for the connected application. You must select a user object, not a role, group, or container.

**System Classification**

**Classification:** Select the classification of the connected application. This information is displayed in the reports. The options are:

- Mission-Critical
- Vital
- Not-Critical
- Other

  If you select Other, you must specify a custom classification for the connected application.

**Environment:** Select the type of environment the connected application provides. The options are:

- Development
- Test
- Staging
- Production
- Other

  If you select Other, you must specify a custom classification for the connected application.

**Connection and Miscellaneous Information**

**Connection and miscellaneous information:** This set of options is always set to hide, so that you do not make changes to these options. These options are system options that are necessary for reporting to work.
NetIQ Corporation strives to ensure that our products provide quality solutions for your enterprise software needs. The following issues are currently being researched. If you need further assistance with any issue, please contact Technical Support.

- When you modify the Office 365 user name or password and restart the Azure AD driver, there is an increase in the Exchange service memory.
- If you modify the description for a group on Identity Vault, the changes are reflected on Office 365 and Exchange portals, but not on Azure portal.
- Delete the group description for a group in the New Azure portal. Save the changes and refresh the page. The saved changes are not reflected. This behavior is not seen in the Classic Azure portal.
- If you delete security, distribution, or Office 365 groups from Office 365, the driver cannot restore these groups. Microsoft does not support restoring these groups. For more information, see the Microsoft documentation.
- User assignments to some exchange admin roles fail and displays the following error message:
  com.novell.nds.dirxml.driver.azure.exceptions.ChannelException: Add-RoleGroupMember

This issue is observed because some exchange admin roles do not support direct user assignments.

NOTE: This issue is specific to 5.0.1 version of the driver.